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1. Description and scope 
The shade-from-shading toolbox can be used for 3D reconstruction of epigraphic squeezes, 
inscriptions, paper embossments, wax seals, and other flat objects that have been inscribed or 
embossed. The reconstruction is performed, using the technique presented in the paper: Barmpoutis, 
A., Bozia, E. and Wagman, R., 2010. A novel framework for 3D reconstruction and analysis of ancient 
inscriptions. Journal of Machine Vision and Applications, vol. 21(6), pp. 989-998. 
https://doi.org/10.1007/s00138-009-0198-7 

The method requires 2 or 4 images of the object acquired with distinct lighting orientations, using a 
conventional flatbed document scanner or fixed camera. Typically, 2 images, one taken with 
horizontal scanning light, and one with vertical scanning light, suffice for porous materials with 
uniform color, such as epigraphic squeezes. However, more complex objects such as shinny or colored 
surfaces may require 4 images.   

The tool has been used in several digitization projects such as those undertaken in collaboration with 
the British Museum (M. Amin, A. Barmpoutis, M. Berti, E. Bozia, J. Hensel, and F. Naether. “The Digital 
Rosetta Stone Project.” In Ancient Egypt, New Technology: The Present and Future of Computer 
Visualization, Virtual Reality and other Digital Humanities in Egyptology, R. Lucarelli, J. Roberson, and 
S. Vinson (ed.), Harvard Egyptological Studies 17, Brill, Dec 2022, ISBN 978-90-04-50128-7. 
https://doi.org/10.1163/9789004501294), the University of Venice (Antonetti, C., Matijašić, I., De 
Vido, S. and Mignosa, V., 2017. Digital Epigraphy at the Greek Epigraphy Laboratory, Ca’ Foscari 
University of Venice. Historika, vol. 7, pp. 491-502. https://journals.openedition.org/historika/419), 
and the University of Lyon (Levivier, A., Leblanc, E. and Brunet, M., 2016. E-STAMPAGES : 
archivage et publication en ligne d’une ectypothèque d’inscriptions grecques. Les nouvelles de 
l'archéologie [En ligne], vol. 145, pp. 24-27. https://doi.org/10.4000/nda.3801). 

The tool can be accessed at the following link: https://www.digitalepigraphy.org/db/app/sfs 
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2. User Login 

To begin, you first need to be logged into the software. To do this, select the “New” button 
from under the “Project” drop-down menu. 

 

After doing this, you will be prompted with a window labelled “Access Error” to select the 
“Login” option 

                 

 

 

Did you know? 

The home screen shows 
examples of various 
reconstruction projects 
that you can use as a 
reference. 

Useful tip 

The app remembers you 
for several hours, so you 
only have to login once in 
the beginning of your 
session. 
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After selecting “Login”, a menu will appear with several login options. Third-party authentication 
providers will provide us with your name and email. You can use your own institutional login if 
your institute, university, or organization has subscribed to any of the available authentication 
providers.  

For example, the following images demonstrate how a user from the University of Florida can 
use their UFL.EDU credentials through Google. In this case the user will click first “Continue with 
Google” then, type in their UF email: username@ufl.edu and finally login with the University of 
Florida dual authentication system.  
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Useful tip 

Selecting the “Open” 
option will allow you to 
view and interact with 
previously created 
projects. 

3. Create and Organize Projects 

After logging into the program, you will be back at the home screen—this time logged in your 
account. To begin a new project, select the “New” button from under the “Project” drop-down 
menu.  

 

 

 

This will open a window that allows you to name, save, and create folders and projects.  
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Important note 

Make sure to select a 
folder. If you don’t, then 
you will not be able to 
create a project. 

To create a new project, select a folder that you would like to create the project under, create a 
name for it in the text box, and then select “Save”. 

 

 
 
 
 

 

 

 

To create a folder, select the option with a yellow folder ( ) icon on it. In the text box, write 
the name for that folder and select “Save”. 
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If you need to rename any of your projects or folders, first select which project or folder you are 
planning on renaming and then click the text box icon ( ) directly to the right of the yellow 
folder. This will prompt you with another window in which you can type a new name, then select 
“Submit” 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can copy and paste references of any file by selecting the “Pick” (copy reference) icon ( ) 
and then, after selecting a different list/folder of projects, click the “Put” icon ( ). 

If you wish to share a folder or project, select said item and then click the share icon ( ). This 
will open a new window where you can copy URLs in order to share them. 

Selecting the ( ) icon will open a new drop-down menu with another list of options that will 
help you navigate the menu: 

•  - Reloads the menu, allowing for any new files or projects to be added into the 
menu. 

•  - Deletes whatever item/project you are currently selecting  
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4. Import Images 

The shape-from-shading method requires 2 or 4 images of your artifact. The images could be 
taken either with a fixed camera or with a conventional flatbed paper scanner. The images should 
be taken under different lighting directions in order to capture how the light is reflected on the 
tridimensional details of the artifact when illuminated from different lighting angles.  

For example, in the case of an epigraphic squeeze, you can place the squeeze on the scanner and 
take one scan, and then rotate the squeeze 90 degrees and take a second scan. You will notice 
that the shading is different because of the difference in the lighting orientation. 

 

If you scan the back face of the squeeze, i.e. the side that was originally touching the inscription, 
you need to flip the images horizontally in order to make the text legible. The two images below 
show an example of a pair of scanned images. In the first image, the vertical lines are highlighted 
(left side of vertical lines is brighter) because the light hits the surface from left to right. In the 
second image, the horizontal lines are highlighted (bottom side of vertical lines is brighter) 
because the light hits the surface from bottom to top. 

   

Light orientation: From left to right                        Light orientation: From bottom to top 

 

Rotate 90 degrees 
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Useful tip 

Selecting “Clear Image 
List” will remove all 
current images in your 
project. 

To begin your 3D reconstruction project, you will first need to import the corresponding scanned 
images. You can do this by selecting “Import Images” tab from the drop-down menu in the top 
right of the screen.  

 

 

Then after selecting this, the file selector window will appear. You will first need to import images 
into your files before bringing them into your project. To do this, simply select your images from 
your computer and drag and drop them within the folder you want them in.  
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When you have the images you want in your files, you can then import them into your project 
page. All you need to do is select them from the menu and then select “Open”  

 

 

 

 

 

 

 

 

 

 

 

 

Once you have your images imported into your project, you need to declare the corresponding 
lighting orientation, according to the different direction of lighting each of your pictures was 
taken with. This can be done by selecting the corresponding lighting angle from the drop-down 
menu.  
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Did you know? 

The markers can be 
resized to a convenient 
size by dragging the 
corners or sides of the 
marked region.    

Useful tip 

Make sure you select 
locations for your markers 
that can be easily 
identified on all images.  

5. Align Images 

The next step is to register the two images. You can do this by selecting the “Registration” tab.  

To perform the alignment, you need to define markers on the first image. To create a marker, 
select the ( ) icon from the top right of the screen and then click somewhere on the 
object. These markers can be altered (moved and resized) to cover the desired area.  
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After doing this as many times as needed to encompass the main identifiers of the object, select 
the next image. You will now need to align the translucent markers onto their corresponding 
locations on the next image, as seen below:  

 

 

 

 

The markers can be rotated in any direction to match the image optimally. 

 

 

Example 

The marker is misaligned 
in this example. We need 
to move it lower to the 
image to the correct 
position. 

Example 

The marker is now 
properly aligned. 
Optionally, you can test 
the alignment using the 
“Test Alignment” button.  
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6. 3D Reconstruction  

After finishing registration, you can now select the “3D Reconstruction” tab. Here you can select 
from the drop-down menu which type of reconstruction you would like to preform; it is 
recommended to select the “Intermediate” option.  

 

You may also select the “Custom” option in order to set the various variables used in creating the 
3D model to more specific values. When you select the “Custom” option and attempt to 
reconstruct the model a window will appear that allows you to change the resolution as well as 
the number of subdivisions and iterations. After selecting your chosen values, you click “Start 
Reconstruction” to begin the creation of the model.  

 

The ”Fast – Good results” preset option corresponds to Resolution=0.5, Subdivisions=5, 
Iterations=50, the “Intermediate – Better results” option corresponds to Resolution=1.0, 
Subdivisions=5, Iterations=50, and the “Slow – Best results” option corresponds to 
Resolution=1.0, Subdivisions=5, and Iterations=200.   
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After choosing your type of reconstruction, finalize it by selecting “Reconstruct”. This will take a 
few seconds or minutes based on the size of your images and then it will present you with a 
preview of the reconstructed normal map and height map of your object. If you are satisfied with 
the way it looks, you can select “Save”. Perhaps add here sth to the effect of “if you are not 
satisfied…” or “I you would like to try again…” 
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7. Visualization  

After finalizing your project, you can view the results in the interactive visualization viewer. Here 
you can drag your mouse to light the inscription as well as use the other visualization options in 
the toolbar on the right of the screen. 
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Did you know? 

Each project has a unique 
URL. You can use these 
URLs to share your work 
through… including social 
media.      

Useful tip 

You can use the “Embed 
URL” to embed your 3D 
reconstructions in other 
websites, databases, 
archives, courses, etc.    

8. Sharing and Downloading Data 

When you are ready to share your finished product, you can select the “Share” option from the 
“Project” drop-down menu in the top right. This will present you with a selection of three URLs 
that you can use to share the project  
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You can also download the various aspects of the projects, such as the height and normal maps, 
by selecting the “Data” menu and then clicking the aspect you would like to download. 

 

 

This will open your chosen aspect in a new window where, after selecting the “File” menu, you 
are able to download the data.  
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9. Citing and acknowledging this tool  
 
If you use this tool in your research, we kindly request that you cite one or more of the 
following publications based on their relevance to your work: 
 
The shape from shading algorithm used in this tool was presented in the following paper: 
 

• Barmpoutis, A., Bozia, E. and Wagman, R., 2010. A novel framework for 3D 
reconstruction and analysis of ancient inscriptions. Journal of Machine Vision and 
Applications, vol. 21(6), pp. 989-998. https://doi.org/10.1007/s00138-009-0198-7 

 

The digital epigraphy toolbox was first presented in the following white paper for the US 
National Endowments for the Humanities: 

• Barmpoutis, A., Digital Epigraphy Toolbox, Humanities Commons, February 28, 2013, 
pp. 1-11. http://dx.doi.org/10.17613/M64W9R 
 

The original version of the Digital Epigraphy Toolbox was made possible with a startup grant 
from the National Endowment for the Humanities, Office of Digital Humanities, Award HD-
51214-11. https://securegrants.neh.gov/publicquery/main.aspx?f=1&gn=HD-51214-11 

 

 

 

 


